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PROGRAM OUTCOMES (POs) 

Engineering Graduates will be able to: 

1. Engineering knowledge: Apply the knowledge of mathematics, science, engineering 

fundamentals, and an engineering specialization to the solution of complex engineering problems. 

 

2. Problem analysis: Identify, formulate, review research literature, and analyze complex 

engineering problems reaching substantiated conclusions using first principles of mathematics, 

natural sciences, and engineering sciences. 

 

3. Design / development of solutions: Design solutions for complex engineering problems and 

design system components or processes that meet the specified needs with appropriate 

consideration for the public health and safety, and the cultural, societal, and environmental 

considerations. 

 

4. Conduct investigations of complex problems: Use research-based knowledge and research 

methods including design of experiments, analysis and interpretation of data, and synthesis of the 

information to provide valid conclusions. 

 

5. Modern tool usage: Create, select, and apply appropriate techniques, resources, and modern 

engineering and IT tools including prediction and modeling to complex engineering activities with 

an understanding of the limitations. 

 

6. The engineer and society: Apply reasoning informed by the contextual knowledge to assess 

societal, health, safety, legal and cultural issues and the consequent responsibilities relevant to the 

professional engineering practice. 

 

7. Environment and sustainability: Understand the impact of the professional engineering 

solutions in societal and environmental contexts, and demonstrate the knowledge of, and need for 

sustainable development. 

 

8. Ethics: Apply ethical principles and commit to professional ethics and responsibilities and 

norms of the engineering practice. 

 

9. Individual and team work: Function effectively as an individual, and as a member or leader in 

diverse teams, and in multidisciplinary settings. 

 

10. Communication: Communicate effectively on complex engineering activities with the 

engineering community and with society at large, such as, being able to comprehend and write 

effective reports and design documentation, make effective presentations, and give and receive 

clear instructions. 

 

11. Project management and finance : Demonstrate knowledge and understanding of the 

engineering and management principles and apply these to one’s own work, as a member and 

leader in a team, to manage projects and in multi disciplinary environments. 

 

12. Life-long learning: Recognize the need for, and have the preparation and ability to engage in 

independent and life-long learning in the broadest context of technological change 
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DEPARTMENT OF COMPUTER SCIENCE & 

INFORMATION TECHNOLOGY 
 

GENERAL LABORATORY INSTRUCTIONS 
 

1. Students are advised to come to the laboratory at least 5 minutes 

before (to the starting time), those who come after 5 minutes will not be 

allowed into the lab. 

2. Plan your task properly much before to the commencement, 

come prepared to the lab with the synopsis / program / experiment 

details. 

3. Student should enter into the laboratory with: 

a. Laboratory observation notes with all the details (Problem 

statement, Aim, Algorithm, Procedure, Program, Expected Output, etc.,) 

filled in for the lab session. 

b. Laboratory Record updated up to the last session experiments 

and other utensils (if any) needed in the lab. 

c. Proper Dress code and Identity card. 

4. Sign in the laboratory login register, write the TIME-IN, and occupy 

the computer system allotted to you by the faculty. 

5. Execute your task in the laboratory, and record the results / output in 

the lab observation notebook, and get certified by the concerned faculty. 

6. All the students should be polite and cooperative with the 

laboratory staff, must maintain the discipline and decency in the 

laboratory. 

7. Computer labs are established with sophisticated and high end branded 

systems, which should be utilized properly. 

8. Students / Faculty must keep their mobile phones in SWITCHED 

OFF mode during the lab sessions. Misuse of the equipment, misbehaviors 

with the staff and systems etc., will attract severe punishment. 

9. Students must take the permission of the faculty in case of any urgency 

to go out; if anybody found loitering outside the lab / class without 

permission during working hours will be treated seriously and punished 

appropriately. 

10. Students should LOG OFF/ SHUT DOWN the computer system before 

he/she leaves the lab after completing the task (experiment) in all aspects. 

He/she must ensure the system / seat is kept properly. 

 

 
HEAD OF THE DEPARTMENT PRI
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1.Introduction to various Data Visualization tools 

 

Understanding Data: Data refers to raw facts, statistics, or information collected or stored 

in various formats, such as numbers, text, images, audio, or video. Data can be categorized into 

two main types: 

1. Structured Data: This type of data is organized and follows a clear format, such as data 

in a spreadsheet, database, or table. Each data point has a specific category or field, 

making it easy to analyze. 

2. Unstructured Data: Unstructured data lacks a specific format and can include text 

documents, emails, social media posts, images, and videos. Analyzing unstructured data 

can be more challenging because it doesn't fit neatly into rows and columns. 

Where to Find Data: There are various sources to find data, depending on your needs: 

1. Open Data Portals: Many governments and organizations publish datasets for public 

use. Examples include data.gov, the World Bank's data portal, and data sources provided 

by universities and research institutions. 

2. Websites and APIs: Some websites and online services provide APIs (Application 

Programming Interfaces) that allow you to access their data programmatically. For 

example, Twitter offers an API for accessing tweets. 

3. Data Marketplaces: There are platforms like Kaggle, Data.gov, and AWS Data 

Exchange where you can find a wide range of datasets for different purposes. 

4. Web Scraping: You can gather data from websites by using web scraping tools and 

libraries like BeautifulSoup or Scrapy (make sure to respect website terms of use and 

legal restrictions). 

5. Surveys and Research: Conducting your own surveys or research is another way to 

collect data tailored to your specific needs. 

Foundations for Building Data Visualizations: Before creating data visualizations, it's 

important to lay a solid foundation: 

1. Define Your Purpose: Clearly understand why you're creating the visualization. What 

message or insight do you want to convey to your audience? 

2. Know Your Audience: Consider who will be viewing your visualization. Tailor it to 

their level of expertise and expectations. 

3. Data Cleaning and Preprocessing: Ensure your data is clean and ready for analysis. 

This may involve handling missing values, outliers, and transforming data if necessary. 

4. Select the Right Visualization Type: Choose the most appropriate chart or graph type 

for your data and message. Common types include bar charts, line charts, pie charts, 

scatter plots, and heatmaps. 

5. Design Principles: Follow design principles such as simplicity, clarity, and consistency. 

Use appropriate colors, labels, and legends. 

6. Interactivity: Consider adding interactive elements to your visualization, such as tooltips 

or filters, to enhance user engagement and understanding. 

7. Accessibility: Ensure your visualizations are accessible to all users, including those with 

disabilities. Use alt text for images and provide text alternatives when necessary. 
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Creating Your First Visualization: 

 To create your first data visualization, follow these steps: 

1. Choose a Tool: Select a data visualization tool or library that suits your needs. Popular 

options include Excel, Tableau, Power BI, Python libraries likeMatplotlib or 

Seaborn, and JavaScript libraries like D3.js. 

2. Load Your Data: Import your data into the chosen tool, whether it's from a file, 

database, or API. 

3. Select the Visualization Type: Based on your data and purpose, choose the appropriate 

chart type. For example, if you have time-series data, a line chart might be suitable. 

4. Create the Visualization: Use the tool's features to design and create your visualization. 

Input your data, customize the appearance, and add labels and titles. 

5. Analyze and Iterate: Analyze the visualization to ensure it effectively communicates 

your message. Make adjustments as needed to improve clarity and impact. 

6. Share Your Visualization: Export or share your visualization with your target audience, 

whether it's through a report, presentation, or interactive web page. 

7. Gather Feedback: Collect feedback from viewers to refine your visualization and make 

it more informative and engaging. 

What is Data Visualization? 

Data visualization is a graphical representation of quantitative information and data by using 

visual elements like graphs, charts, and maps.  

Data visualization convert large and small data sets into visuals, which is easy to understand and 

process for humans.  

Data visualization tools provide accessible ways to understand outliers, patterns, and trends in 

the data. 

In the world of Big Data, the data visualization tools and technologies are required to analyze 

vast amounts of information.  

Data visualizations are common in your everyday life, but they always appear in the form of 

graphs and charts. The combination of multiple visualizations and bits of information are still 

referred to as Info graphics.  

Data visualizations are used to discover unknown facts and trends. You can see visualizations in 

the form of line charts to display change over time. Bar and column charts are useful for 

observing relationships and making comparisons. A pie chart is a great way to show parts-of-a-

whole. And maps are the best way to share geographical data visually. 

Today's data visualization tools go beyond the charts and graphs used in the Microsoft Excel 

spreadsheet, which displays the data in more sophisticated ways such as dials and gauges, 

geographic maps, heat maps, pie chart, and fever chart. 

 

 

 



DV Lab 2024-25 

 

 

Department of CSE 

 

Page 3 

 

 

What makes Data Visualization Effective? 

Effective data visualization are created by communication, data science, and design collide. Data 

visualizations did right key insights into complicated data sets into meaningful and natural.  

American statistician and Yale professor Edward Tufte believe useful data visualizations 

consist of ?complex ideas communicated with clarity, precision, and efficiency. 

 

To craft an effective data visualization, you need to start with clean data that is well-sourced and 

complete. After the data is ready to visualize, you need to pick the right chart. 

After you have decided the chart type, you need to design and customize your visualization to 

your liking. Simplicity is essential - you don't want to add any elements that distract from the 

data. 

Importance of Data Visualization 

Data visualization is important because of the processing of information in human brains. Using 

graphs and charts to visualize a large amount of the complex data sets is more comfortable in 

comparison to studying the spreadsheet and reports. 

Data visualization is an easy and quick way to convey concepts universally. You can experiment 

with a different outline by making a slight adjustment. 
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Data visualization have some more specialties such as 

• Data visualization can identify areas that need improvement or modifications. 

• Data visualization can clarify which factor influence customer behavior. 

• Data visualization helps you to understand which products to place where. 

• Data visualization can predict sales volumes. 

Data visualization tools have been necessary for democratizing data, analytics, and making data-

driven perception available to workers throughout an organization. They are easy to operate in 

comparison to earlier versions of BI software or traditional statistical analysis software. This 

guide to a rise in lines of business implementing data visualization tools on their own, without 

support from IT. 

Why Use Data Visualization? 

1. To make easier in understand and remember. 

2. To discover unknown facts, outliers, and trends. 

3. To visualize relationships and patterns quickly. 

4. To ask a better question and make better decisions. 

5. To competitive analyze. 

6. To improve insights. 

Tableau is available in two ways:- 

• Tableau Public (Free) 

• Tableau Desktop (Commercial)  

• Here is a comparison between the Tableau Public and Tableau Desktop 

Tableau Public 

• Tableau Public is a free and open-source. 

• Tableau public data source can connect to Excel and Text files. 

• Tableau public can be installed on Window and Mac operating system.  

• Data and Visualizations are not secured in the Tableau public because it is available in 

public.  

• In Tableau public, data cannot be obtained from different data sources as it is limited to 

connect only Excel and Text files. 

• Tableau public uses the details at Personal level. 

Tableau Desktop  

• Tableau Desktop is a paid source, personal edition- $35 per month and professional 

edition- $70 per month. 

• Tableau desktop data source can connect to any data source file, including databases, web 

applications, and more. 

• Tableau desktop can also install on Window and Mac operating system. 

• Data and Visualization are secured in Tableau desktop. 

• In Tableau desktop, data can extract from various data sources and stored as Tableau 

extract file. 

• Tableau desktop uses the details at Professional and Enterprise level. 
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2. Getting started with Tableau Software using Data file formats, connecting 

your Data to Tableau, creating basic charts(line, bar charts, Tree maps),Using 

the Show me panel 

Introduction to Tableau and Installation 

 
Tableau is a data visualization tool that provides pictorial and graphical representations of 

data. It is used for data analytics and business intelligence. Tableau provides limitless 

data exploration without interrupting flow of analysis. With an intuitive drag and drop 

interface, user can uncover hidden insights in data and make smarter decisions faster. 

Tableau can be downloaded from the following 

website 

after downloading, the following is the screen appears. 

 

Click the licence agreement checkbox and then click on install button. After installation, click 

on Tableau Public icon to run Tableau. Following is the Tableau Public home screen. 
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 Connecting to Data and preparing data for visualization in Tableau 

 
Tableau supports connecting to a wide variety of data, stored in a variety of places. For 

example, data might be stored on computer in a spread sheet or a text file, or in a big data, 

relational, or cube (multidimensional) database on a server in enterprise or the data can be from 

a public domain available on the web. 

Data can be imported in Tableau Public from Connect panel on left side. For example, an Excel 

sample data set was loaded into Tableau as follows: 

 

After clicking on open, screen is as follows: 
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The data store page appears as above. The left pan shows that above dataset consists of 3 

worksheets. If we drag orders table, screen appears as follows: Tableau automatically identifies 

the data type of each column. 
 

Now drag Returns table onto the Canvas to the right of Orders table. This shows the relation 

between the two tables Orders and Returns. 
 

 

 

 



DV Lab 2024-25 

 

 

Department of CSE 

 

Page 8 

 

 

If we click on the link between Orders and Returns table names at the top gives the summary 

of the relationship between the tables. Now rename the data store and click on Sheet1 at the 

bottom left to proceed. This step creates a data extract which improves query performanc
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  Data Visualization 

We can perform various visualization operations on data in Tableau. Some of them are bar cart, 

histogram, bubble chart, gantt chart, scatter plot, heat map etc. 

Bar chart: 

Bar charts can be created in 3 variations in Tableau: Horizontal bars, stacked bars, side-by-side 

bars. 

Horizontal bars can be created by selecting that type of chart from Show Me menu on right 

hand side of Canvas. The type of chart in box on right hand side represents horizontal bar graph. 
 

In similar to above, stacked bar graph can be created and the result is shown below. 
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Side-by-side bar chart can be created in following way. 
 

Line graph: Line graph can be continuous or discrete. 

Continuous line graph is shown below: 
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Discrete line graph is shown below: 

 
 

Pie chart: 
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Bubble chart: 
 

Heat map: 
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 3.Tableau Calculations, Overview of SUM, AVR, and Aggregate features, 

Creating custom calculations and fields 

 Data aggregation and statistical functions: 

We can apply various aggregation and statistical functions on data such as count, minimum, 

maximum, standard deviation, variance etc. This is shown below. This can be done by right 

clicking on the required field of dataset, click on Default properties and click on aggregation. 
 

Or the above operation can be done by creating a calculated field as shown below. To create a 

calculated field, click on the down arrow button beside search tab above Tables panel, drag a 

field to that calculated field window. 
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Then click on apply and results are shown below: 

 

 
 

In the same way we can apply any aggregate or statistical function on data with the help of 

calculated fields. 
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SUM Function 

The SUM function in Tableau calculates the total sum of a numeric field. You can use it to find the 

sum of values in a column or as part of a more complex calculation. To use SUM, simply drag and 

drop a numeric field into the "SUM" shelf, or you can create a calculated field using the SUM 

function. 

 

  

 

 

 

 

 

 

 



DV Lab 2024-25 

 

 

Department of CSE 

 

Page 16 

 

 

AVG (Average) Function 

The AVG function calculates the average (mean) value of a numeric field. Like SUM, you can use it 

by dragging a numeric field into the "AVG" shelf or creating a calculated field with the AVG 

function. 
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Aggregate Functions: 

Tableau provides a range of aggregate functions that allow you to perform calculations on groups of 

data. Common aggregate functions include SUM, AVG, COUNT, MIN (minimum value), and MAX 

(maximum value). These functions are particularly useful when you want to analyze data at different 

levels of granularity (e.g., by category, region, or time period). 
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Creating Custom Calculations 

Tableau allows you to create custom calculations using calculated fields. Here's how to create a 

custom calculation: 

1. Create a New Calculated Field 

In the Data Source Pane, right-click on your data source and select "Create Calculated Field". 

 
  

Alternatively, you can create a calculated field by right-clicking on a shelf in your worksheet and 

choosing "Create Calculated Field". 

2. Enter Your Calculation: 

In the calculated field editor, you can use functions, operators, and field references to define your 

calculation. 

For example, you can create a calculated field to calculate profit margin as (SUM([Profit]) / 

SUM([Sales])) * 100. 
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3. Name and Save the Calculated Field: 

Give your calculated field a meaningful name. 

Click the "OK" or "Apply" button to save the calculated field. 
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4. Use the Calculated Field in Your Worksheet: 

You can now use the calculated field like any other field in your worksheet. Drag it to the Rows or 

Columns shelf, use it in filters, or create visualizations based on it. 
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4)Applying new data calculations to your visualizations, Formatting 

Visualizations, Formatting Toolsand Menus, Formatting specific parts of the 

view. 

Solution : 

Applying New Data Calculations to Visualizations 

1. Drag and Drop Calculated Fields: 

To apply your newly created calculated fields to a visualization, simply drag and drop them onto the 

appropriate shelves in your worksheet. For example, you can drag a calculated field to the Rows or 

Columns shelf, use it in filters, or place it on the Marks card to control the appearance of marks. 
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2. Filter with Calculated Fields: 

Create filters using calculated fields to control which data points are displayed in your visualization. 

You can use calculated fields to filter by specific criteria, such as a calculated date range or a custom 

ranking. 
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 Formatting Visualizations 
Tableau provides a wide range of formatting options to make your visualizations more appealing and 

informative: 

1. Format Pane: 

On the left side of the Tableau interface, you'll find the Format pane. It allows you to format various 

aspects of your visualization, such as fonts, colors, lines, shading, and borders. Simply select the 

element you want to format and use the options in the Format pane to make changes. 
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2. Marks Card: 
The Marks card, located above your visualization, offers formatting options specific to the type of 

marks you're using (e.g., color, size, label). Click on the Marks card to access these options and 

modify how your data is represented. 
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3. Axis and Gridlines: 

You can format axis labels, titles, and gridlines to improve the readability of your visualization. 

Right-click on an axis or gridline to access formatting options. 

 
  

4. Legends and Color Scales: 
Customize legends and color scales to provide context for your visualizations. You can change 

colors, labels, and the position of legends to match your data. 
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Formatting Tools and Menus 

Tableau provides several formatting tools and menus to help you refine the appearance of your 

visualizations: 

1. Format Menu: 

The Format menu at the top of the Tableau interface provides access to various formatting options, 

including font styles, shading, borders, alignment, and more. You can use this menu to format text, 

labels, and other elements. 
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2. Worksheet Menu: 

In the Worksheet menu, you'll find options to format the entire worksheet, including background 

color, borders, and worksheet title. You can also adjust the worksheet size. 

 
  

3. Dashboard Menu: 
If you're working with dashboards, the Dashboard menu allows you to format the entire dashboard 

layout, including background, size, and title. 
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Formatting Specific Parts of the View 

Tableau lets you format specific elements of your visualization: 

1. Annotations: 

You can add annotations to your visualizations to highlight important points or provide additional 

context. Format these annotations using the options available when you right-click on an annotation. 
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2. Tooltips: 

Customize tooltips to display relevant information when users hover over data points. You can 

format tooltips to show or hide specific fields and control their appearance. 
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3. Headers and Titles: 

Format headers, titles, and subtitles for clarity and consistency. Use the Format pane or the Format 

menu to adjust text formatting, alignment, and shading. 
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DV Lab 2024-25 

 

 

Department of CSE 

 

Page 34 

 

 

5.Editing and Formatting Axes, Manipulating Data in Tableau data, Pivoting 

Tableau data. 

Solution : 

Editing and Formatting Axes: 
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1. Edit Axis Title: 

• Click on the axis title you want to edit. 

• You can now modify the title text, font, size, color, and alignment using the Format pane or 

the toolbar at the top. 
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2. Edit Axis Labels: 

• Right-click on an axis and select "Edit Axis." 

• In the Edit Axis dialog box, you can change the formatting of labels, tick marks, and other 

axis-related properties. 
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3. Scale and Range: 

• To change the scale or range of an axis, right-click on it and select "Edit Axis." 

• In the dialog box, adjust the Minimum and Maximum values, scale, or range according to 

your needs. 
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Manipulating Data in Tableau data 

 
  

Change Data Type 
If Tableau has inferred a wrong data type for a column, the data type can be changed by clicking on 

the data type symbol in the column header 
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New Column(Calculated Fields) 
Calculated fields can be used if you need to create customized logic for manipulating certain data 

types or data values. There are a large-range of functions available in Tableau that can used 

individually or collectively for data manipulation 
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Pivoting Tableau data 
Data pivoting enables you to rearrange the columns and rows in a report so you can view data from 

different perspectives 
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Next 3rd view is created as follows for profit for each subcategory in the category with averages. 
 

After creating individual views, now a Dashboard can be created by clicking on create 

dashboard at the toolbar. 
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after clicking on new dashboard option, the screen is shown below. 
 

now the sheets or views which are created earlier can be drag and dropped on this dashboard. 

The above three created views are placed in the dashboard as follows. One can follow their 

own way of importing sheets on the dashboard. After creating dahsboard, title can be given to 

the dashboard from Dashboard tab. Dahsboard can be customized in terms of its appearance 

by the user if requied. Dashboard once created can be saved on users system and can be 

retrieved whenever required. 
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6.Structuring your data, Sorting and filtering Tableau data, Pivoting Tableau 

data 

Structure Data for Analysis: 

Data preparation is the process of getting well formatted data into a single table or multiple related 

tables so it can be analyzed in Tableau. This includes both the structure, i.e. rows and columns, as 

well as aspects of data cleanliness, such correct data types and correct data values. 

How structure impacts analysis 

The structure of our data may not be something we can control. The rest of this topic assumes that 

we have access to the raw data and the tools needed to shape it, such as Tableau Prep Builder. 

However, there may be situations when we can't pivot or aggregate our data as desired. It is often 

still possible to perform the analysis but we may need to change your calculations or how we 

approach the data. For an example of how to perform the same analysis with different data structures.  

Data Structure 

Tableau Desktop works best with data that is in tables formatted like a spreadsheet. That is, data 

stored in rows and columns, with column headers in the first row.  

What is a row? 

A row, or record, can be anything from information around a transaction at a retail store, to weather 

measurements at a specific location, or stats about a social media post. 

It's important to know what a record (row) in the data represents. This is the granularity of the data. 

Here, each record is a day Here, each record is a month 

 

 

Tip:A best practice is to have a unique identifier (UID), a value that identifies each row as a unique 

piece of data. Think of it like the social security number or URL of each record. In Superstore, that 

would be Row ID. Note that not all data sets have a UID but it can't hurt to have one. 
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Aggregation and Granularity 

What is a field or column? 

A column of data in a table comes into Tableau Desktop as a field in the data pane, but they are 

essentially interchangeable terms.  A field of data should contain items that can be grouped into a 

larger relationship. The items themselves are called values or members (only discrete dimensions 

contain members). 

The values which are allowed in a given field are determined by the domain of the field .For 

example, a column for "grocery store departments" might contain the members "deli" "bakery", 

"produce", etc., but it wouldn't include "bread" or "salami" because those are items, not departments. 

Phrased another way, the domain of the department field is limited to just the possible grocery store 

departments. 

Additionally, a well-structured data set would have a column for "Sales" and a column for "Profit", 

not a single column for "Money", because profit is a separate concept from sales. 

• The domain of the Sales field would be values ≥ 0, since sales cannot be negative. 

• The domain of the Profit field, however, would be all values, since profit can be negative. 

Note: Domain can also mean the values present in the data. If the column "grocery store department" 

erroneously contained "salami", by this definition, that value would be in the domain of the column. 

Categorizing fields 

Each column in the data table comes into Tableau Desktop as a field, which appears in the Data 

pane. Fields in Tableau Desktop must be either a dimension or  either discrete or continuous . 

• Dimensions are qualitative, meaning they can't be measured but are instead described. 

Dimensions are often things like city or country, eye color, category, team name, etc. 

Dimensions are usually discrete. 

• Measures are quantitative, meaning they can be measured and recorded with numbers. 

Measures can be things like sales, height, clicks, etc. In Tableau Desktop, measures are 

automatically aggregated; the default aggregation is SUM. Measures are usually continuous. 

• Discrete means individually separate or distinct. Toyota is distinct from Mazda. In Tableau 

Desktop, discrete values come into the view as a label and they create panes. 

• Continuous means forming an unbroken, continuous whole. 7 is followed by 8 and then it's 

the same distance to 9, and 7.5 would fall midway between 7 and 8. In Tableau Desktop, 

continuous values come into the view as an axis. 

• Dimensions are usually discrete, and measures are usually continuous. However, this is not 

always the case. Dates can be either discrete or continuous. 

o Dates are dimensions and automatically come into the view as discrete (. A trend line 

applied to a timeline with discrete dates will be broken into multiple trend lines, one 

per pane. 

o We can chose to use continuous dates if preferred .A trend line applied to a timeline 

with continuous dates will have a single trend line for the entire date axis.  

In Tableau Prep, no distinction is made for dimensions or measures. Understanding the concepts 

behind discrete or continuous are important, for things like the detail versus summary presentation of 

data in the profile pane. 
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• Detail: the detail view shows every domain element as a discrete label and has a visual 

scrollbar to provide a visual overview of all the data. 

• Summary: the summary view shows the values as binned on a continuous axis as a 

histogram. 

Sorting: 
• There are many ways to sort data in Tableau. When viewing a visualization, data can be 

sorted using single click options from an axis, header, or field label. In the authoring 

environment, additional sorting options include sorting manually in headers and legends, 

using the toolbar sort icons, or sorting from the sort menu. 

• There are multiple ways to sort a visualization with single click sort buttons. 

• In all cases, one click sorts descending, two clicks sorts ascending, and three clicks clear the 

sort. 
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Sort from an axis 

1. Hover over a numerical axis to bring up the sort icon. 

2. Click the icon to sort.  

 
 

Sort from a header 

1. Hover over a header to bring up the sort icon. 

2. Click the icon to sort. 

Sort from a field label 

1. Hover over a field label to bring up the sort icon.  

The sort icon for a field label is slightly different from a header or axis. The default option is 

alphabetical sorting, but there’s also a menu where you can choose to sort by a field in the 

view. 
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2.Click the A-Z icon to sort alphabetically. Or, click the menu to select a field to sort by. The 

icon switches to the bar icon and you can click to sort. 

 

Sort: Hues are arranged in descending order by Metric B.  

In this example, the sort is applied to the outermost dimension (Hue) based on total Metric B. (Metric 

B is aggregated for all the colors within each hue and Hue is sorted. Therefore, Purple is first, then 

Green, then Blue.) 

Missing sort icons 

If the sort icons don't appear, this functionality may have been turned off or it might not be possible 

to sort the view. Sort icons aren't available on the axes in scatterplots or for table calculations. For 

example, scatterplots can't be sorted from a numerical axis because the positions of the marks are 

fully determined by the data.  

Sort options while authoring 

In an authoring environment, additional options are available.  

Sort from the toolbar 

1. Select the dimension you wish to sort. 

If you don’t select a field before sorting, the default behavior is to sort the deepest dimension. 

2. Choose the appropriate sort button (ascending or descending) in the toolbar.  
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In this example, the sort is applied to Hue unless the Material field is selected before sorting. The 

toolbar sort also applies to the leftmost measure, in this case Metric B. To sort by Metric A, it would 

be necessary to reverse their order on the Columns shelf or use another method of sorting. This 

example demonstrates the effect of sorting by Material. Hue is removed from the view. 

Sort by drag and drop: 

To manually sort, select a header in a viz or on a legend and drag it to the correct location—a heavy 

black line indicates where to drop the header. 

 

Note: Sorting on a legend also changes the order of the marks, not simply how the legend is 

displayed. Whatever is bottommost in the legend becomes the bottommost mark in the viz. This can 

either mean closest to the axis or header, or actually underneath in the case of scatterplots and other 

viz types that may have overlapping marks.  
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Filter Data from Your Views 
Applies to: Tableau Cloud, Tableau Desktop, Tableau Server 

Filtering is an essential part of analyzing data.  

Filtering Order of Operations 

Tableau performs actions on your view in a very specific order; this is called the Order of 

Operations. Filters are executed in the following order: 

1. Extract filters 

2. Data source filters 

3. Context filters 

4. Filters on dimensions (whether on the Filters shelf or in filter cards in the view) 

5. Filters on measures (whether on the Filters shelf or in filter cards in the view). 

Note: When you drag a discrete dimension to the Filters shelf, the Filter dialog box offers four tabs 

for filtering: General, Wildcard, Condition, and Top. The settings on each of these tabs are additive 

starting with the General tab; what you set on each tab will affect the filter results on each tab to the 

right. 

Select to keep or exclude data points in your view: 

You can filter individual data points (marks), or a selection of data points from your view. For 

example, if you have a scatter plot with outliers, you can exclude them from the view so you can 

better focus on the rest of the data.  

To filter marks from the view, select a single mark (data point) or click and drag in the view to select 

several marks. On the tooltip that appears, you can: 

• Select Keep Only to keep only the selected marks in the view. 
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• Select Exclude to remove the selected marks from the view. 

 

Note: These filtering options are not available if a Wildcard Match filter is already specified for the 

same field.  

Select headers to filter data:  

You can also select headers to filter them from your view.  

To filter entire rows or columns of data from your view, select the header in the view. On the tooltip 

that appears, select to Exclude or Keep Only the selected data. 

When you select a table header that is part of a hierarchy, all of the next level headers are also 

selected. For example, the view shown below consists of two unrelated dimensions placed on the 

Columns shelf, and two levels of the same hierarchy placed on the Rows shelf. 

The selected row headers include the Furniture member of the Category dimension, and the Binders 

and Labels members of the Sub-category dimension. When Furniture is selected, all members from 

the next (inner) level in the hierarchy are automatically selected. In this case, that means the 

Bookcases, Chairs, Furnishings, and Tables members.  
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Drag dimensions, measures, and date fields to the Filters shelf : 

Another way to create a filter is to drag a field directly from the Data pane to the Filters shelf.  

 

When you add a field to the Filters shelf, the Filter dialog box opens so you can define the filter. The 

Filter dialog box differs depending on whether you are filtering categorical data (dimensions), 

quantitative data (measures), or date fields. 

Filter categorical data (dimensions): 

Dimensions contain discrete categorical data, so filtering this type of field generally involves 

selecting the values to include or exclude.  

When you drag a dimension from the Data pane to the Filters shelf in Tableau Desktop, the 

following Filter dialog box appears: 



DV Lab 2024-25 

 

 

Department of CSE 

 

Page 54 

 

 

 

• General: Use the General tab to select the values you want to include or exclude.  

• Wildcard (Tableau Desktop only): Use the Wildcard tab to define a pattern to filter on. For 

example, when filtering on email addresses you might want to only include emails from a 

specific domain. You can define a wildcard filter that ends with "@gmail.com" to only 

include Google email addresses. 

• Condition: Use the Condition tab in the Filter dialog box to define rules to filter by. For 

example, in a view showing the average Unit Price for a collection of products, you may 

want to only show the Products that have an average unit price that is greater than or equal to 

$25. You can use the built-in controls to write a condition or you can write a custom formula. 

• Top: Use the Top tab in the Filter dialog box to define a formula that computes the data that 

will be included in the view. For example, in a view that shows the average Time to Ship for 

a collection of products, you can decide to only show the top 15 (or bottom) products by 

Sales. Rather than having to define a specific range for Sales (e.g., greater than $100,000), 

you can define a limit (top 15) that is relative to the other members in the field (products).  

Important Note: Each tab adds additional definitions to your filter. For example, you can select to 

exclude values under the General tab, and also add limits under the Top tab. Selections and 

configurations from both tabs are applied to your filter.  

 

At any time, you can see the definitions of your filter under Summary on the General tab.  

Filter quantitative data (measures): 

Measures contain quantitative data, so filtering this type of field generally involves selecting a range 

of values that you want to include.  

When you drag a measure from the Data pane to the Filters shelf in Tableau Desktop, the following 

dialog box appears: 
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Select how you want to aggregate the field, and then click Next.  

In the subsequent dialog box, you're given the option to create four types of quantitative filters: 

Range of Values: Select the Range of Values option to specify the minimum and maximum values 

of the range to include in the view. The values you specify are included in the range. 

At Least: Select the At Least option to include all values that are greater than or equal to a specified 

minimum value. This type of filter is useful when the data changes often so specifying an upper limit 

may not be possible. 

At Most: Select the At Most option to include all values that are less than or equal to a specified 

maximum value. This type of filter is useful when the data changes often so specifying a lower limit 

may not be possible. 

Special: Select the Special option to filter on Null values. Include only Null values, Non-null values, 

or All Values. 

Note: If you have a large data source, filtering measures can lead to a significant degradation in 

performance. It is sometimes much more efficient to filter by creating a set containing the measure 

and then apply a filter to the set 

Filter dates : 

When you drag a date field from the Data pane to the Filters shelf in Tableau Desktop, the following 

Filter Field dialog box appears: 
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You can select whether you want to filter on a relative date; filter between a range of dates; or select 

discrete dates or individual dates to filter from the view. 

• Filter relative dates: Click Relative dates to define a range of dates that updates based on 

the date and time you open the view. For example, you may want to see Year to Date sales, 

all records from the past 30 days, or bugs closed last week. Relative date filters can also be 

relative to a specific anchor date rather than today. 

• Filter a range of dates: Select Range of dates to define a fixed range of dates to filter. For 

example, you may want to see all orders placed between March 1, 2009 and June 12, 2009.  

• Filter discrete dates: Select a discrete date value in the dialog box if you want to include 

entire date levels. For example, if you select Quarters, you can choose to filter specific 

quarters (e.g. Q1, Q2, Q3, Q4) from your view, regardless of the year.  

• Latest date preset: If you want to ensure that only the most recent date in a data source is 

selected in the filter when the workbook is shared or opened, select a discrete date such as 

Month/Day/Year or Individual Dates and then, on the General tab, select Filter to latest date 

value when workbook is opened.  
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Notes: When you filter to the latest date value, this setting applies only to data source filters 

in a workbook.  

 

In the order of operations, the latest date filter is global to the workbook, while context filters 

apply per worksheet. The latest date is determined just after the workbook opens for first use, 

after data source filters, but before context filters. At that point the date is set, and the latest 

date preset is used as a dimension filter. 

 

If you are using additional filters in views, the latest date value setting may result in an empty 

view with no data when those additional filters do not select data from the latest date in the 

database. 

 

On Tableau Server and Tableau Cloud, presets are applied when the view first loads in the 

browser, but not when the browser or data is refreshed. 

• Filter individual dates: Select Individual dates to filter specific dates from your view. 

• Additional date filter options: When you select Relative dates or Range of dates, the Filter 

dialog box opens. In that dialog box, you can define a Starting date or Ending date. You can 

also select Special to include null dates, non-null dates, or all dates. 

Filter table calculations: 

To create a table calculation filter, create a calculated field, and then place that field on the Filters 

shelf. 
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Filters based on table calculations do not filter out underlying data in the data set, because table 

calculation filters are applied last in the order of operations. This means Tableau evaluates any table 

calculations in the view first, and then applies table calculation filters on the results in the current 

view. 

Apply table calculation filter to totals 

When you show totals in a view and you want a table calculation filter to apply to the totals, you can 

select Apply to totals in the drop-down menu for that filter (on the Filters shelf). This option lets you 

decide when a table calculation filter should be applied to totals. 

   

This options is available when you show totals in the view, and you add a table calculation filter to 

the view. Select Apply to totals to apply the table calculation filter to all of the results in the table, 

including the totals. 

Display interactive filters in the view: 

When an interactive filter is shown, you can quickly include or exclude data in the view.  

Note: In web authoring, interactive filters are automatically added to the view when you drag a field 

to the Filters shelf.  

To show a filter in the view: 

1. In the view, click the field drop-down menu and select Show Filter.  



DV Lab 2024-25 

 

 

Department of CSE 

 

Page 59 

 

 

 

The field is automatically added to the Filters shelf (if it is not already being filtered), and a 

filter card appears in the view. Interact with the card to filter your data. 

  

Note: In Tableau Desktop, you can add an interactive filter to the view for a field that is not currently 

used in the view. To do so, In the Data pane, click the field drop-down menu, and then select Show 

Filter.  

Set options for filter card interaction and appearance: 

After you show a filter, there are many different options that let you control how the filter works and 

appears. You can access these options by clicking the drop-down menu in the upper right corner of 

the filter card in the view.  

 

Some options are available for all types of filters, and others depend on whether you’re filtering a 

categorical field (dimension) or a quantitative field (measure).  

You can customize how filters appear in the view, in dashboards, or when published to Tableau 

Server or Tableau Cloud. 

Here are some of the general filter card options: 

• Edit Filter - This option opens the main Filter dialog box so you can further refine the filter 

by adding conditions and limits. 

• Remove Filter - Removes the filter from the Filters shelf and removes the filter card from the 

view. 

• Apply to worksheets - Allows you to specify whether the filter should apply to only the 

current worksheet or be shared across multiple worksheets.  

• Format Filters (Tableau Desktop only) - Customize the font and colors of all your filter cards 

in the view. 
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• Only relevant values - Specifies which values to show in the filter. When you select this 

option other filters are considered and only values that pass these filters are shown. For 

example, a filter on State will only show the Eastern states when a filter on Region is set. 

You can use the toggle at the top of the filter card to switch between this option and the All 

Values in Database option. 

• All values in hierarchy - Specifies which values to show in the filter. When you create a filter 

from a hierarchical field, this option is selected by default. Filter values are displayed based 

on relevance of the parent/child relationships in the hierarchy. 

• All values in database - Specifies which values to show in the filter. When you select this 

option all values in the database are shown regardless of the other filters on the view. 

• All values in context (Tableau Desktop only) - When one of the filters in the view is a 

context filter, select this option on a different filter to only display values that pass through 

the context filter.  

• Include values - When this option is selected, the selections in the filter card are included in 

the view. 

• Exclude values - When this option is selected, the selections in the filter card are excluded 

from the view. 

• Hide Card (Tableau Desktop only) - Hides the filter card but does not remove the filter from 

the Filters shelf. 

Filter card modes 

You can control the appearance and interaction of your filter card in the view by selecting a filter 

card mode. 

To select a filter card mode, in the view, click the drop-down menu on the filter card and then select 

a mode from the list.  

 

The types of filter card modes you see in the list of options depend on whether your filter is on a 

dimension or a measure. Below you can find brief descriptions of the types of filter card modes 

available for dimensions and measures.  

For dimensions, you can choose from the following filter modes: 

• Single Value (List): Displays the values of the filter as a list of radio buttons where only a 

single value can be selected at a time.  

• Single Value (Dropdown): Displays the values of the filter in a drop-down list where only a 

single value can be selected at a time. 
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• Single Value (Slider): Displays the values of the filter along the range of a slider. Only a 

single value can be selected at a time. This option is useful for dimensions that have an 

implicit order such as dates. 

• Multiple Values (List):Displays the values in the filter as a list of check boxes where 

multiple values can be selected. 

• Multiple Values(Dropdown): Displays the values of the filter in a drop-down list where 

multiple values can be selected. 

• Multiple Values (Custom List): Displays a text box where you can type a few characters 

and search for the value. Alternatively, you can type or paste a list of values into the text box 

to create a custom list of values to include. 

• Wildcard Match: Displays a text box where you can type a few characters. All values that 

match those characters are automatically selected. You can use the asterisk character as a 

wildcard character. For example, you can type “tab*” to select all values that begin with the 

letters “tab”. Pattern Match is not case sensitive. If you are using a multidimensional data 

source, this option is only available when filtering single level hierarchies and attributes. 

For measures, you can choose from the following filter modes: 

• Range of Values/Dates: shows the filtered values as a pair of sliders that you can adjust to 

include or exclude more values. Click on the upper and lower limit readouts to enter the 

values manually. 

The darker area inside the slider range is called the data bar. It indicates the range in which 

data points actually lie in the view. Use this indicator to determine a filter that makes sense 

for the data in your data source. For example, you may filter the Sales field to only include 

values between $200,000 and $500,000 but your view only contains values between 

$250,000 and $320,000. The range of data you can see in the view is indicated by the data 

bar while the sliders show you the range of the filter. 

• Note: Data bars only show in filters where the filtered field is also used in the view (e.g., on 

Columns, Rows, or on the Marks card, and son on) and are at the same aggregation level as 

the field on the Filters shelf. For example, a filter on SUM(Sales) will only display data bars 

if the SUM(Sales) field is used in the view. It won't show if AVG(Sales) is used in the view. 

Even though in both scenarios, the filtered field, Sales is used in the view; in the latter case 

the aggregation is different than the aggregation of the filter. 

• At Least/Starting Date: shows a single slider with a fixed minimum value. Use this option 

to create a filter using an open ended range. 

• At Most/Ending Date: shows a slider with a fixed maximum value. Use this option to create 

a filter using an open ended range. 

• Relative to Now: this option shows a control where you can define a dynamic date range that 

updates based on when you open the view. The option is only available for filters on 

continuous date fields. 

• Browse periods: shows common date ranges such as past day, week, month, three months, 

one year, and five years. This option is only available for filters on continuous date fields. 

Note: When you expose a filter for Measure Values or Measure Names as a single value list, 

selecting All will automatically convert the filter to a multiple values list.  

Customize filter cards 

In addition to the general filter options and the filter modes, you control how your filter appears in 

the worksheet, on dashboards, or when published to the web even further in Tableau Desktop. 
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To customize filters, click the filter card drop-down menu and select Customize.  

 

You can select from the following options: 

• Show “All” Value - toggles whether to show the “All” option that displays by default in 

multiple values and single value lists.  

• Show Search Button - toggles whether to show the search button at the top of the filter. 

• Show Include/Exclude - toggles whether to show the Include Values and Exclude Values 

commands on the filter card menu. When shown, users can switch the filter between include 

and exclude modes. 

• Show Control Types - toggles whether to let users change the type of quick filter shown. 

For example, when shown, a user can change a multiple values list to a compact list.  

• Show More/Fewer button - toggles whether to show the More/Fewer button at the top of 

the filter. 

• Show All Values button - toggles whether to display the Show All Values button on the 

filter card.  

Whenever data is excluded in the filter, the small red "x" appears on the Show All Values 

button. When all values are showing, the red "x" disappears. 

 

• Show Apply Button - toggles whether to show the Apply button at the bottom of the filter. 

When shown, changes to the filter are only applied after you click the button. Pending 

changes are indicated with a green color. This option is only available in multiple values lists 

and dropdowns. This options is available in web authoring. 
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• Show Readouts - controls whether the minimum and maximum values are displayed as text 

above a range of values. The readouts can be used to manually type a new value instead of 

using the sliders. 

• Show Slider - controls whether the slider displays. When this option is cleared, the filter only 

displays the readouts. 

• Show Null Controls - shows a drop-down list that lets you control how the filter handles null 

values. You can select from values in a range; values in a range and null values; null values 

only, non-null values, or all values.  

• Note: Not all of the above options are available for views published to Tableau Server or 

Tableau Cloud. 

 Pivot Data from Columns to Rows: 

Sometimes, analyzing data that is stored in a crosstab format can be difficult in Tableau. When 

working with Microsoft Excel, text file, Google Sheets, and .pdf data sources, you can pivot your 

data from crosstab format into columnar format. If you are working with other data sources, you 

can Pivot using custom SQL (Tableau Desktop). 

For example, suppose you have the number of devices sold by quarter for three vendors in three 

separate fields. You can pivot your data so that the vendor is in one field and the number of devices 

sold is in another field. 

 

Pivot the data 

After you have set up the data source, in the grid, select two or more columns. Click the drop-down 

arrow next to the column name, and then select Pivot. New columns called "Pivot field names" and 

"Pivot field values" are created and added to the data source. The new columns replace the original 

columns that you selected to create the pivot. 

 

https://help.tableau.com/current/pro/desktop/en-us/pivot.htm#Pivot
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Add to the pivot 

To add more data to the pivot, select another column, click the drop-down arrow next to the column 

name, and then select Add Data to Pivot. Make sure that the pivot columns and values look as 

expected before you begin your analysis. 

 

  

To remove a pivot, click the drop-down arrow next to the name of a pivot column, and then 

select Remove Pivot. 

• Red fields in the view and fields with exclamation points in the Data pane: Because 

the original fields are replaced with new pivot fields, any references to the original fields 

in the view will no longer work. They cause fields to become red in the view or show a 

red exclamation point next to the field in the Data pane. 

• Null values in the grid: If all of the original fields used in the pivot are removed, for 

example in an extract refresh, null values display in the pivot fields. 

• No pivot option: Pivot appears when you select two or more columns in a single 

Microsoft Excel, text file, Google Sheets, and .pdf data source. If using a different data 

source in Tableau Desktop, you can use custom SQL to pivot. 

   

Pivot using custom SQL (Tableau Desktop) 

You can also use custom SQL to pivot your data, even if you aren't working Excel, text file, 

Google Sheets, and .pdf data sources. When you use the UNION ALL operator in a custom SQL 

query, you can take values from distinct columns and put them into a new column. 

For example, suppose you have a table called Contest. 

Contest 

Runner Start Time End Time 
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Runner Start Time End Time 

Amanda 9/3/2016 3:04 PM 9/3/2016 3:25 PM 

Oscar 9/3/2016 3:04 PM 9/3/2016 3:21 PM 

William 9/3/2016 3:04 PM 9/3/2016 3:16 PM 

To optimize your analysis of this data in Tableau, you can use the following custom SQL query 

to pivot the "Start Time" and "End Time" columns so that their values are in a single column. 

Select [Runner] 

, 'Start' as [Action] 

, [Start Time] as [Time] 

From [Contest] 

Union ALL 

Select [Runner] 

, 'End' as [Action] 

, [End Time] as [Time] 

From [Contest] 

The above custom SQL query does the following: 

• Pivots the Start Time column header into a string value called Start and adds that value 

to a new column called Action. 

• Pivots the End Time column header into a string value called End and adds that value to 

a new column called Action. 

• Pivots the Start Time and End Time columns so that their values are in a new column 

called Time. 

The following table shows the results of this custom SQL query. 

Runner Action Time 

Amanda Start 9/3/2016 3:04 PM 

Oscar Start 9/3/2016 3:04 PM 

William Start 9/3/2016 3:04 PM 

Amanda End 9/3/2016 3:25 PM 

Oscar End 9/3/2016 3:21 PM 

William End 9/3/2016 3:16 PM 

 To pivot data using custom SQL 

1. Connect to your data. 

2. Double-click the New Custom SQL option in the left pane. For more information, 

see Connect to a Custom SQL Query. 

https://help.tableau.com/current/pro/desktop/en-us/customsql.htm
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3. In the Edit Custom SQL dialog box, copy and paste the following custom SQL query 

and replace the contents with information about your table: 

Select [Static Column] 

, 'New Value (from Column Header 1)' as [New Column Header] 

, [Pivot Column Values 1] as [New Values] 

From [Table] 

Union ALL 

Select [Static Column] 

, 'New Value (from Column Header 2' as [New Column Header] 

, [Pivot Column Values 2] as [New Values] 

From [Table] 

Union ALL 

Select [Static Column] 

, 'New Value (from Column Header 3' as [New Column Header] 

, [Pivot Column Values 3] as [New Values] 

From [Table] 

Where the following is true: 

o Static Column: A comma-delimited list of the columns from Table, both 

dimensions and measures, which should not be included in the pivot. 

o New Value (from Column Header 1-3): New names that you give to the original 

column headers, which are used as row values in the pivot. 

o Pivot Column Values 1-3: The columns whose values need to be pivoted into a 

single column. 

o New Column Header: The name you give the new column that contains the new 

row values from New Value (from Column Header 1-3). 

o New Values: The name give the new column that contains the original values 

from Pivot Column Values 1-3. 

o Table: The table that you connected to. 

4. Click OK. 
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7. Advanced Visualization Tools: Using Filters, Using the Detail panel, using 

the Size panels, customizing filters, Using and Customizing tooltips, 

Formatting your data with colors: 
 

Create Views in Tooltips (Viz in Tooltip) 
Applies to: Tableau Cloud, Tableau Desktop 

As you craft views and look for ways to reveal more details about data to your audience, you can 

embed visualizations within tooltips—also known as "Viz in Tooltip."  

 

When a user hovers over a mark, the tooltip displays relevant data and details from another 

visualization filtered to that mark.  

You can show related vizzes in tooltips to help your audience engage with the data at a different or 

deeper level, while keeping them in the current context and maximizing the space available for the 

current view.  

General steps to create a Viz in Tooltip 

1. Create a visualization in the source worksheet in Tableau. 

2. Create a visualization in a target worksheet view to serve as the Viz in Tooltip. Give the 

worksheet a name that helps you identify it as a Viz in Tooltip. 

4. In the source worksheet, click Tooltip in the Marks card. In the Tooltip Editor, insert a 

reference to the Viz in Tooltip target worksheet.  

Optional: Hide the target sheet for the Viz in Tooltip.  

5. Test the resulting Viz in Tooltip by hovering over different marks in the source worksheet 

view. If the Viz in Tooltip is too large for the tooltip window, adjust the height and width of 

the target worksheet visualization. You might also consider simplifying the structure and 

detail in the target visualization.  

Note: By default, Viz in Tooltip is filtered on All Fields. Change the level of detail for Viz in 

Tooltip by defining a filter on Selected Fields.  
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Configure a Viz in Tooltip 

You will need a source worksheet visualization and a target worksheet visualization to create a Viz 

in Tooltip.  

These steps use the example of a source view that is a map showing sales profits by state, and a 

target sheet with a chart that shows profits by product sub-category. 

Create the source and target visualizations in a worksheet 

1. In Tableau, figure out the worksheet that you want to use as your source visualization. Or 

build a new visualization on a new worksheet. This will be your source view. 

2. Create a new worksheet to serve as the target visualization. 

Keep the number of filters used in the target view to a minimum.  

3. Name the target view so that you will be able to identify it in a list of other sheets. 

Insert a reference to the target worksheet in the source worksheet tooltip 

1. In the source sheet, click the Tooltip button in the Marks card to open the Tooltip Editor. 
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2. Click the Insert menu in the Tooltip Editor. In the Insert menu, select Sheets, and then 

select a target sheet. 

 

The markup for the Viz in Tooltip is automatically added. (In this example, the original 

markup fields have been removed.) 

 

Example of markup automatically generated for Viz in Tooltip 

This is the resulting markup for this example: 

<Sheet name="Tooltip: Profit by Sub-Category" maxwidth="300" maxheight="300" 

filter="<All Fields>"> 

By default, the Viz in Tooltip is filtered on All Fields (filtered on all fields possible, and on 

the most specific level of detail).  
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Click OK. 

3. Go back to the source sheet and test the Viz in Tooltip. Hover over different marks to see the 

resulting Viz in Tooltip. Make adjustments to the target view as necessary to improve the Viz 

in Tooltip. 

 

The Viz in Tooltip in this example shows a message that indicates that some of the data in 

the target view is not being shown. If you see this message, you can adjust the height and 

width settings in the parameters for the Viz in Tooltip to make the view size larger. 

Change the size of the Viz in Tooltip 

You can manually change the maxwidth and maxheight values to resize the Viz in Tooltip. The 

default size is 300 by 300 pixels. To change the size, manually replace "300" with another value. If 

you need to set the value greater than 600 pixels, you might want to reconsider whether the target 

view is a good candidate for Viz in Tooltip. 

1. In the source sheet, click the Tooltip button in the Marks card to open the Tooltip Editor. 

2. Select the number value for maxwidth and maxheight and type a different value to replace it. 

For example: 

<Sheet name="Tooltip: Profit by Sub-Category" maxwidth="500" maxheight="500" 

filter="<All Fields>"> 

3. Click OK 
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Example of a Viz in Tooltip set to 500 pixels width and height. The author also created more 

space for the header text in the in the target sheet view. 

Change the filter for the Viz in Tooltip 

By default, Viz in Tooltip is filtered on All Fields. This means the view is filtered on all dimensions 

in the current view (not including fields on the Filters shelf), at the most specific level of detail. 

You can change the level of detail for Viz in Tooltip by defining a filter on selected fields, similar to 

filtering on Selected Fields in Filter Actions. 

1. In the source sheet, click the Tooltip button in the Marks card to open the Tooltip Editor. 

2. Place your cursor within the filter value (filter="<place cursor here>"), and then click the 

Insert menu to select an available field. Or, manually replace the <All Fields> value with the 

name of a field in the view. For example: 

<Sheet name="Tooltip: Profit by Sub-Category" maxwidth="300" maxheight="500" 

filter="<State>"> 

You can also filter more than one selected field by separating the field names with a comma. 

For example: 

<Sheet name="Tooltip: Profit by Sub-Category" maxwidth="300" maxheight="500" 

filter="<Country>,<State>"> 

To filter on date level, you will need to include the string that specifies the date level with the 

field name. For example: 

<Sheet name="Tooltip: Profit by Month" maxwidth="300" maxheight="300" 

filter="<MONTH(Order Date)>"> 

Note: The date filter in the Viz in Tooltip script must match exactly the date level of the field 

in the view. 
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Hide or show a Viz in Tooltip worksheet 

You can hide and show a worksheet used for Viz in Tooltip with options similar to those for 

dashboards and stories. 

Hide a Viz in Tooltip worksheet 

Note: If the source sheet is hidden for a dashboard, you will first need to first unhide that 

worksheet from its dashboard to access it.  

To hide a Viz in Tooltip worksheet, from the tab for the target worksheet that is the Viz in 

Tooltip, select Hide. 
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Show a Viz in Tooltip worksheet 

To show a Viz in Tooltip worksheet, from the tab for the source worksheet, select Unhide All 

Sheets. 

 

Examples of Viz in Tooltip 

When you create a Viz in Tooltip, users can hover over a mark to examine details-on-demand, 

within the context of the original view. A Viz in Tooltip is a static image of data from another 

view that is relevant to a mark in the current view. Hovering over or selecting the mark reveals 

data from another sheet—filtered for that mark—in its tooltip.  

Use Viz in Tooltip to show: 

• Data at another level of detail 
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• Different, but relevant data 

 

• How the value of a mark changes over time 

 

• Multiple visualizations in one tooltip 
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• A legend for the main view 

 

When you show related views in tooltips, you can help your audience engage with the data at a 

deeper level, while maximizing the space available for the current view. 

Tips and notes on using and configuring Viz in Tooltip 

• You can use worksheets to create a Viz in Tooltip, but you cannot use dashboards or 

stories to create a Viz in Tooltip. 

• A Viz in Tooltip is a static image of a target view, not an interactive sheet. A Viz in 

Tooltip cannot have its own Viz in Tooltip. 

• You will need a source worksheet visualization and a target worksheet visualization to 

create a Viz in Tooltip. You will need to create a target view to make it available in the 

Tooltip Editor.  

• Use a standard naming scheme for the target sheets you plan to show in tooltips, such as 

Tooltip: Name of View. Using a standard naming scheme will help you keep track of 

views that you are using in tooltips. 

• For the target view, consider the size of the view data and how the view will look in the 

tooltip. You will be able to specify the size for the Viz in Tooltip when you configure it, 

but you will need to check to see how it is displaying and possibly make adjustments to 

the view before you publish it. 
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Remember that the target view is displayed in the context of the source view. Keeping 

the target visualization simple can help with performance and reduce cognitive load. 

• If you click Show Me in the source sheet and it changes the view structure, all tooltip 

edits including Viz in Tooltip references will be reset. You will need to reconfigure the 

Viz in Tooltip. 

• One target sheet can be referenced by one Viz in Tooltip source sheet at a time, because 

filters are applied directly to the referenced sheet. When a sheet is already being used as a 

target sheet in a tooltip, it becomes unavailable for selection in the Tooltip Editor. 
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8.Creating dashboard and story telling,creating your first dashboard and 

story,design for  different displays,add interactivity to your dashboard, 

distributing and publishing your visualization. 
 

Create a Dashboard 

Create a dashboard, and add or replace sheets 

You create a dashboard in much the same way you create a new worksheet. 

1. At the bottom of the workbook, click the New Dashboard icon: 

 

2. From the Sheets list at left, drag views to your dashboard at right. 

 

3. To replace a sheet, select it in the dashboard at right. In the Sheets list at left, hover over 

the replacement sheet, and click the Swap Sheets button. 

 

Add interactivity 

• In the upper corner of sheet, enable the Use as Filter option to use selected marks in the 

sheet as filters for other sheets in the dashboard. 
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Add dashboard objects and set their options 

In addition to sheets, you can add dashboard objects that add visual appeal and interactivity. 

Here's guidance about each type: 

• Horizontal and Vertical objects provide layout containers that let you group related 

objects together and fine-tune how your dashboard resizes when users interact with them. 

• Text objects can provide headers, explanations, and other information. 

• Image objects add to the visual flavor of a dashboard, and you can link them to specific 

target URLs.  

• Web Page objects display target pages in the context of your dashboard. Be sure to 

review these web security options, and be aware that some web pages don't allow 

themselves to be embedded 

• Blank objects help you adjust spacing between dashboard items. 

• Navigation objects let your audience navigate from one dashboard to another, or to other 

sheets or stories. You can display text or an image to indicate the button's destination to 

your users, specify custom border and background colors, and provide informational 

tooltips. 

• Download objects let your audience quickly create a PDF file, PowerPoint slide, or PNG 

image of an entire dashboard, or a crosstab of selected sheets. Formatting options are 

similar to Navigation objects. 

• Extension objects let you add unique features to dashboards or integrate them with 

applications outside Tableau. 

• Ask Data objects let users enter conversational queries for specific data source fields, 

which authors optimize for specific audiences such as sales, marketing, and support staff. 

 

 

 

 

 

 

https://help.tableau.com/current/pro/desktop/en-us/dashboards_refine.htm#Use_a_layout_container
https://help.tableau.com/current/pro/desktop/en-us/dashboards_create.htm#Be_security-savvy
https://help.tableau.com/current/pro/desktop/en-us/dashboard_extensions.htm
https://help.tableau.com/current/pro/desktop/en-us/ask_data_lenses.htm
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Add an object 

From the Objects section at left, and drag an item to the dashboard on the right: 

 

Copy objects 

You can copy and paste objects either within the current dashboard, or from dashboards in other 

sheets and files. You can even copy objects between Tableau Desktop and Tableau in your web 

browser. 

You can't, however, copy the following: 

• Sheets in a dashboard 

• Items that rely on a specific sheet, such as filters, parameters, and legends 

• Layout containers with something you can't copy inside them, like a sheet or filter 

• Objects on a device layout 

• Dashboard titles 

1. Select a dashboard object, and from the object menu, select Copy Dashboard Item. Or 

from the main menu, select Dashboard > Copy Selected Dashboard Item. 

 

2. Go to the dashboard where you want to paste the object. Then either select nothing to 

paste in the upper-left corner of the dashboard, or select an existing item to paste next to. 

3. In Tableau Desktop, choose File > Paste. In a browser, either choose Edit > Paste or use 

the keyboard shortcut for pasting. 

4. The object is pasted 10 pixels below and to the right of the upper-left corner of the 

dashboard or the selected object. To move the pasted object, drag the handle at the top. 
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Set options for objects 

Click the object to select it. Then click the arrow in the upper corner to open the shortcut menu.  

 

Detailed options for Image objects 

With the Image object, you can either insert image files into dashboards or link to images posted 

on the web. In either case, you can specify a URL the image opens when clicked, adding 

interactivity to your dashboard. 

1. From the Objects section at left, drag an Image object to your dashboard at right. Or, on 

an existing Image object in a dashboard, click the pop-up menu in the upper corner, and 

choose Edit Image. 

2. Click either Insert Image File to embed an image file into the workbook or Link to 

Image to link to a web-based image. 

Consider linking to a web-based image when: 

o The image is very large and your dashboard audience will view it in a browser 

o The image is an animated GIF file.  
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o  

3. If you're inserting an image, click Choose to select the file. If you're linking to an image, 

enter its web URL. 

4. Set remaining image fitting, URL linking, and alt text options. (Alt text describes the 

image in screen-reading applications for improved accessibility.) 

Detailed options for Navigation and Download objects 

Navigation and Download objects have several unique options that help you visually indicate a 

navigation destination or file format. 

 

A navigation button using text for the button style 

1. In the upper corner of the object, click the object menu, and choose Edit Button. 

 

2. Do one of the following: 

o From the Navigate to menu, choose a sheet outside the current dashboard. 

o From the Export to menu, choose a file format. 

3. Choose image or text for Button Style, specify the image or text you want to appear, and 

then set related formatting options. 

4. For Tooltip text, add explanatory text that appears when viewers hover over the button. 

This text is optional and typically best used with image buttons. Show and hide objects 

by clicking a button 

Show/Hide buttons let dashboard viewers toggle the visibility of dashboard objects, revealing 

them only when necessary. 
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How hidden objects affect layouts 

When a floating object is hidden, it simply reveals any objects beneath it. Show/Hide buttons can 

be particularly helpful when you want to temporarily hide a floating group of filters to reveal 

more of a visualization. 

 

When a tiled object is hidden, the results depend on the object's level in the layout hierarchy. 

• In most cases, you'll want to place objects you plan to hide in a Horizontal or Vertical 

layout container, because hidden objects will have their space filled in by other objects in 

the container. 

• By contrast, in the Tiled layout container at the very top of the layout hierarchy, a hidden 

object leaves blank space behind. 

Add and configure a Show/Hide button 

1. Select a dashboard object. 

2. From the pop-up menu in the upper corner of the object, select Add Show/Hide Button. 

 

3. From the button menu, choose Edit Button. 

 

 

 

4.Set these options: 
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o Dashboard Item to Show/Hide specifies the target object. (An object can be the 

target of only one Show/Hide button at a time. Choose None if you want to target 

the object with another Show/Hide button.) 

o Button Style specifies whether image or text displays for the button. 

o Button Appearance specifies how the button looks when the item is both shown 

and hidden. Click Item Shown and Item Hidden to choose different images or 

text for each state. 

o Tooltip text provides explanatory text that appears when viewers hover over the 

button. (For example, you might enter "Show or hide filters" for a container with 

filter menus.) 

5. If necessary, drag the button to a different location or resize it to better fit your layout. 

Create a Story 

Create a story point 

1. Click the New Story tab. 

 

Tableau opens a new story as your starting point: 

 

2. In the lower-left corner of the screen, choose a size for your story. Choose from one of 

the predefined sizes, or set a custom size, in pixels: 

 

3. By default, your story gets its title from the sheet name. To edit it, right-click the sheet 

tab, and choose Rename Sheet. 

If you're using Tableau Desktop, you can also rename a story by double-clicking the title. 
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4. To start building your story, double-click a sheet on the left to add it to a story point. 

In Tableau Desktop, you can also drag sheets into your story point. 

 

When you add a sheet to a story point, that sheet remains connected to the original sheet. 

If you modify the original sheet, your changes will automatically be reflected on the story 

points that use it. 

5. Click Add a caption to summarize the story point. 

In Tableau Desktop, you can highlight a key takeaway for your viewers by dragging a 

text object to the story worksheet and typing a comment. 

6. To further highlight the main idea of this story point, you can change a filter or sort on a 

field in the view. Then save your changes by clicking Update on the story toolbar above 

the navigator box: 

 

7. Add another story point by doing one of the following: 

o Click Blank to use a fresh sheet for the next story point. 

 

o Start customizing a story point and click Save as New on the toolbar above the 

navigator box. 
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o Click Duplicate to use the current story point as the basis for a new one. 

Explore layout options 

You can refine the look of your story using the options on the Layout tab. 

1. Click the Layout tab. 

2. Choose a navigator style that best suits your story, and show or hide the next and 

previous arrows. 

 

Format a story 

Resize captions (Tableau Desktop only) 

Sometimes the text in one or more of your captions is too long to fit inside the height of the 

navigator. In this case, you can re-size the captions vertically and horizontally. 

1. In the navigator, select a caption. 

2. Drag the border left or right to resize the caption horizontally, down to resize vertically, 

or select a corner and drag diagonally to resize the caption both horizontally and 

vertically. 

All captions in the navigator update to the new size. 

 

 

Fit a dashboard to a story 

You can fit a dashboard to the exact size of a story. For example, if your story is exactly 800 by 

600 pixels, you can shrink or expand a dashboard to fit inside that space. 

Click the Size drop-down menu and select the story you want the dashboard to fit inside. 
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•  

Format a story's shading, title, and text objects (Tableau Desktop only) 

To open the Format Story pane, select Format > Story. 

 

Clear all formatting (Tableau Desktop only) 

• To reset a story to its default format settings, click the Clear button at the bottom of 

the Format Story pane. 

• To clear a single format setting, right-click (Windows) or control-click (macOS) the 

format setting you want to undo in the Format Story pane. Then select Clear. 

For example, if you want to clear the alignment of the story title, right-click (control-

click on Mac) Alignment in the Title section, and then select Clear. 



DV Lab 2024-25 

 

 

Department of CSE 

 

Page 87 

 

 

 

Delete a story point 

Click the X in the toolbar above the point's caption: 

 

Present your story 

1. In Tableau Desktop, click the Presentation Mode button  on the toolbar. Or, publish 

the story to Tableau Cloud or Tableau Server, and click the Full Screen button in the 

upper-right corner of the browser. 

2. To step through your story, click the arrow to the right of the story points. Or, in Tableau 

Desktop, use the arrow keys on your keyboard. 

3. To exit Presentation or Full Screen mode, press Esc 

•  

 

 

 

 

 

    

 

 

 

 

 

 

https://help.tableau.com/current/pro/desktop/en-us/publish_workbooks_share.htm
https://help.tableau.com/current/pro/desktop/en-us/publish_workbooks_share.htm
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9.Tableau file types, publishing to Tableau Online, Sharing your 

visualizations, printing, and Exporting. 

Tableau File Types : 

• Workbooks (.twb) – Tableau workbook files have the .twb file extension. Workbooks 

hold one or more worksheets, plus zero or more dashboards and stories. 

• Bookmarks (.tbm) – Tableau bookmark files have the .tbm file extension. Bookmarks 

contain a single worksheet and are an easy way to quickly share your work. 

• Extract (.hyper) – Tableau extract files have the .hyper extension. Extract files are a 

local copy of a subset or entire data set that you can use to share data with others, when 

you need to work offline, and improve performance.  

• Data Source (.tds) – Tableau data source files have the .tds file extension. Data source 

files do not contain the actual data but rather the information necessary to connect to the 

actual data as well as any modifications you've made on top of the actual data  

Changing the Repository Location 

1. Select File > Repository Location. 

2. Select a new folder that will act as the new repository location in the Select a Repository 

dialog box. 

3. Restart Tableau so that it uses the new repository. 

 Share your findings:  

 Use Tableau Public: 

1. Select Server > Tableau Public > Save to Tableau Public. 

2. Enter your Tableau Public credentials in the dialog box. 

 

If you don't have a Tableau Public profile, click Create one now for free  open the Data Source 

page. Then in the top-right corner, change the Connection type from Live to Extract. 
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4. For the second (and last) time, select Server > Tableau Public > Save to Tableau 

Public. 

5. When your browser opens, review your embedded story. It will look like this: 

 

6. Click Edit Details to update the title of your viz, add a description, and more. 

7. Click Save. 

8. To share with colleagues, click Share at the bottom of your viz. 

 

9. To share your story: 

a. Copy the Embed Code and paste it in your web page HTML. 

b. Copy the Link and send the link to your colleagues. 

c. Send an email using your default email client by clicking the email icon. 

d. Share on Twitter or Facebook by clicking the appropriate icon. 
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Use Tableau Server: 

Publish to Tableau Server: 

1. Select Server > Publish Workbook or click Share  on the toolbar. 

2. Enter the name of the server (or IP address) that you want to connect to in the dialog box 

and click Connect. 

 

3. In the Name field, enter Improve Profits in the South. 

4. If you want, enter a description for reference, for example "Take a look at the story I built 

in Tableau Desktop!" 

5. Under Sheets, click Edit, and then clear all sheets except Improve Profits in the South. 

 

6. Click Publish. 

If prompted, enter your server credentials. 

The Publishing Complete dialog box lets you know that your story is ready to view. 
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Send a link to your work: 

1. navigate to the Improve Profits in the South story that you published.  

 

2. Click Improve Profits in the South. 

Your screen will update to look like this: 

 

3. From the menu, select Share. 

 

4. To share your story: 

a. By copying the Embed Code and pasting it in your web page HTML. 

b. Send a link by copying the Link and sending the link to your colleagues. 

c. Send an email by using your default email client: Click the email icon. 

Print Views from Tableau Desktop: 

Set up the page: 
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To begin, select File > Page Setup. 

General settings : 

• Show - Show or hide the title, view, caption, color legend, shape legend, size legend, and 

map legend. 

• Headers and Breaks - Control the appearance of these table elements. 

o Repeat headers and legends on each page - adds table row and column headers at 

the top of each printed page when a view breaks across several pages. 

o Break pages on pane boundaries - prevents page breaks in the middle of a table 

cell. 

• Pages Shelf - If the view uses the Pages Shelf, specify whether to print the current page 

or all pages. 

Layout settings: 

• Legend Layout - If you include one or more legends, select how you want the legends to 

appear on the printed page. 

• Margins - Specify top, bottom, left, and right margins by typing values into the text 

boxes. 

• Centering - Optionally, select whether to center the view horizontally or vertically—or 

both—on the page. 

Print Scaling settings: 

• Print Scaling - Scale a view to fit within a single page or print across multiple pages. 

Select from the following options: 

o Automatic – Scales the view automatically based on the paper size. 

o Scale to – Scales the view to the specified percentage of its original size. 

o Fit to – Scales the view to fit within the specified area. Select the number of 

printed pages across and down. For example, if you have a really wide view that 

is not very tall, you can specify three pages across by one page down. 

• Page Orientation - 

o Use Printer Setting – Use the page orientation that is already specified by the 

printer. 

o Portrait – Presents the view so that it is oriented vertically on the printed page. 

o Landscape – Presents the view so that it is oriented horizontally on the printed 

page. 

The following diagram shows the difference between portrait and landscape page 

orientations. 

 

Print a view 
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After Page Setup settings, select File > Print 

Show Selections: 

When this option is selected any selections you’ve made in the views will be maintained while 

printing. 

Change the Print Range: 

Select from the following print ranges: 

• Entire Workbook - Prints all the worksheets in the workbook. 

• Active Sheet - Prints only the sheet currently displayed in the workbook. 

• Selected Sheets - Prints the selected sheets. 

Print to PDF 

Print to PDF using a Windows computer: 

1. Specify page setup options for each sheet in your workbook. 

2. Select File > Print to PDF. 

 

3. In the Print to PDF dialog box, select the print Range: 

o Entire Workbook ,Active Sheet ,Selected Sheets  

4. Select a Paper Size. If you select Unspecified, the paper size will expand to the 

necessary size to fit the entire view on a single page. 

 

6. Select View PDF File After Printing if you want to automatically open the PDF after 

creating it.  

7. Select whether to Show Selections. When this option is selected the selections in the 

views are maintained in the PDF. 

https://help.tableau.com/current/pro/desktop/en-us/printing.htm#pagesetup
https://help.tableau.com/current/pro/desktop/en-us/printing.htm#pagesetup
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8. Click OK and specify where you want to save the PDF. Then click Save. 

Print to PDF using a Mac computer 

1. Specify page setup options for each sheet in your workbook. 

2. Select File > Print. 

3. In the Print dialog box, click Show Details to select a print range: 

o Entire Workbook,, Active Sheet, Selected Sheets  

4. Click PDF > Save as PDF. 

 

5. Specify where you want to save the PDF, then click Save. 

Export Data from Tableau Desktop 

Export data in the data source 

Export your data to .csv file 

Exporting your data in the Tableau data source using this format creates an independent data 

set and can be a convenient and flexible way to share your data with others.There are two 

primary ways you can export your data in the data source to a .csv file in Tableau:  

 From the Data Source page: On the Data Source page, select Data > Export Data to CSV to 

export all the data in your data source to .csv file. 

From the view: On the sheet tab, drag a field to the Columns or Rows shelf, click the View Data 

icon in the Data pane, and click the Export All button. 

 

Extract your data 

Another way to export all of your data or a subset of your data in the data source is to create an 

extract (.hyper) file. An extract functions as an independent data. 

https://help.tableau.com/current/pro/desktop/en-us/printing.htm#pagesetup
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Export the data source 

After you connect to your data, you can export and save your data source as a Tableau data 

source (.tds) file. Saving the data source creates a shortcut to your remote data  

Export data used in the view 

Export data in the view to Microsoft Access or .csv 

Export the data that is used to generate the view as an Access database (Windows only) or .csv 

file (Mac only). 

1. In Tableau Desktop, select Worksheet > Export > Data. 

2. Select a location and type a name for your Access database or .csv file. 

3. Click Save. 

If you're on Windows, the Export Data to Access dialog box displays to give you the 

option to immediately use the new Access database and continue working in Access 

without interrupting your work flow. 

 

Export crosstab of data in the view to Excel 

If the view you are exporting contains a lot of data, In this case, if you choose to exclude the 

formatting from the export, performance of the export might improve. 

• In Tableau Desktop: select Worksheet > Export > Crosstab to Excel. 

If you're using a Mac, this option opens a dialog box where you can save the file. You 

must then manually open the file in Excel. 

• In Tableau Server or Tableau Cloud, open a view or dashboard and 

select Download > Crosstab. 

Select which sheets from the workbook to export data from. 

Copy data in the view to clipboard 

Copy the data used to generate the view so that you can paste it into another application. 

1. Create a view. 
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2. Select Worksheet > Copy > Data. 

3. Open another application, such as Word, and paste the data into the document. 

 

Copy crosstab of data in the view to clipboard 

Copying a crosstab is restricted by some general conditions: 

• You must copy all records in the view. You cannot copy a subset of records. 

• This option is valid for aggregated views only. It cannot be used on disaggregated views 

of data because a crosstab is by definition an aggregated view of data. This means 

the Aggregate Measures option on the Analysis menu must be selected in order for 

copying a crosstab to work properly. 

• You cannot copy a crosstab if the view contains continuous dimensions such as 

continuous dates and times. 

• Other restrictions may apply depending on the data in your view. 

After the general conditions are met, copy the crosstab. 

1. Create a view. 

 

2. Select Worksheet > Copy > Crosstab. 

3. Open another application, such as Excel, and paste the crosstab. 
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10.Creating custom charts,cyclical data and circular area 

charts,dual axis charts 

Creating custom charts : 

Set up configuration 

 Each time you use this extension you'll want it to be based on different data found on different 

worksheets so, we'll let the dashboard author pick which worksheets and fields should be used in 

a configuration pop-up window. We'll need to build four inputs and a button. We need to collect: 

the source worksheet to build the chart from, the dimension and measure fields to use on that 

worksheet, and the worksheet we want to filter when you click on the chart. 

Set up the canvas 

we'll need to get the dashboard data and create the chart, let's set up the canvas where it will be 

drawn. Make sure to bring in the Tableau Extensions API and the Chart.js library to your 

index.html page. Then set up a canvas element we can use to draw the chart as well as a 

container to help with styling and positioning of the canvas. 

Get the chart data 

In order to build the chart, we'll need to get data from the dashboard, specifically from the 

worksheets and fields selected in the configuration. Once you get the worksheet data you can 

loop through the selected columns that contain the necessary values to plot in the next step. 

Draw the chart 

Now that we have the data let's pass it to Chart.js to plot a chart. Specifically, you can build a 

polar area chart. This will require you to pass the data as well as some options on how you want 

the chart to appear. This is where you can start to add additional customization to your chart. 

Filter the dashboard 

You may want to be able to use the custom chart to filter the rest of your dashboard. We can do 

this by adding an event that triggers whenever a mark is selected in our Chart.js polar area chart. 

Once the event is triggered we can use the data received to apply a filter to the rest of the 

dashboard. 

cyclical data and circular area charts 

WHAT IS A CIRCULAR AREA CHART? 
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It Also known as the Spider or Radar Chart, the Circular Area Chart, this chart shows the 

different dimensions such as scores and rankings of one item. The further out a point is from the 

center, the higher it ranks in a category. 

WHEN TO USE A CIRCULAR AREA CHART 

Circular area charts are a great way to compare members of a dimension in a function of several 

metrics.  

Dual Axis charts: 

What is a Dual Axis Chart? 

Dual-axis charts are a combination of two charts. It is used to visualize two or more different 

measures in two different chart types i.e. it depicts the relationship between two variables with 

different amplitude and scale. 

To create a dual-axis chart we must have one date column and two measures. 

steps to create a Dual Axis Chart 
• Connect a file 

• Drag and Drop Category into the column shelf 

• Drag and Drop Profit and Discount into the row shelf 

• Here, we have two charts present on multiple axes 

 
• Right-click on Sum (Profit) 

• Select Dual-axis from the drop-down 

• We get the desired dual-axis chart 

 
• In the Mark pane, you will get SUM(Discount) and SUM(Profit) 
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• Select the required chart from the drop-down 

• In SUM(Discount) select Bar chart 

• In SUM(Profit) select Line Chart 
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